Provide Advice to Clients		Client Support

Client Support		Provide Advice to Clients

DDICTS315

[bookmark: _GoBack]


Copyright InformationProvide IT Advice to Clients 
ICTSAS305
[image: Data Discovery Logo]
[image: ]
PO Box 15062
City East, Brisbane QLD 4002
Ph	1300 309 744
Fax	(07) 3229 1254
manuals@datadiscovery.com.au
www.datadiscovery.com.au

Computer Training Manual
for ICT11 Information, Digital Media and Technology
ICTSAS305

Author: Paul Watson 
© Data Discovery 2012
Version 1:  April 2012

This manual is copyright. No part of this manual may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying, recording, or by any information storage and retrieval system, without the written permission of Data Discovery.

You have three options when purchasing these manuals:
1.  Purchase a single copy for each user, a class set or a copy for each computer
2.  Purchase a paper Site Licence for making unlimited copies of this manual
3.  Purchase a Copyright licence to alter the contents of the manual

Class sets of these training manuals are available. 
Do not purchase one manual and make your own copies. You have not been given permission to copy even a part of this manual.


The software used in the production of this manual was Microsoft Word 2010, Microsoft Windows 7 and SnagIt 10.
Microsoft®, Microsoft® Windows™, Microsoft® Word for Windows™, Microsoft® Excel for Windows™, Microsoft® PowerPoint™, Microsoft® Access for Windows™, Microsoft® Publisher™, Microsoft® Outlook are registered trademarks of Microsoft Corporation.

All information is correct to the best of the author’s knowledge. The author has made every attempt to ensure accuracy but cannot be held responsible for any loss or damage arising from any information contained or implied in this publication.



Data Discovery
PO Box 15062 
City East,  Brisbane   Q  4002

Ph:   1300 309 744
Fax: (07) 3229 1254
email: manuals@datadiscovery.com.au
website:  www.datadiscovery.com.au






[bookmark: _Toc179014844][bookmark: _Toc179261692][bookmark: _Toc180831657][bookmark: _Toc321930034][bookmark: _Toc362177797][bookmark: _Toc59606193]Table of Contents
Introduction	iii
Elements of Competency	iv
Employability Skills Summary	vi
Table of Contents	viii
Client Support	1
Identifying Support Requirements	2
Identifying Support Environments	7
Service Level Agreements	14
Client Contact	19
Client Identification	21
Clarify the Support Requirement	23
Record the Support Information	27
Implement a Solution	29
Problem Diagnosis	32
Previous Occurrences	32
Locating Documentation	36
Other Investigation Processes	38
Problem Resolution	46
Hardware Resolutions	46
Software Resolutions	49
User Documentation	58
Design	64
Using Software Tools	66
Client Feedback	77
Method Analysis	79
Analysing Feedback	81
Implementing the Change	83
Provide Advice to Clients		Table of Contents
Table of Contents		Provide Advice to Clients
[bookmark: _Toc85284478][bookmark: _Toc175047044][bookmark: _Toc177188984]
Page viii		© Data Discovery 2012
 © Data Discovery 2012		Page iii
[bookmark: _Toc321930035]Client Support
With the enormous selection of hardware and software available today, no single person can possibly acquire and memorise solutions to every problem that arises. Due to this, the support of clients has become a critical part of the daily operations of any IT department. 

Effective client support processes are critical to the running of any computer network.  Support personnel are required to not only ensure that they can identify and manage the resolution processes quickly and effectively, but do so strictly within company IT policies and procedures.  In most workplaces, the process of client support will entail the following processes: 

Answering and logging calls. 
Recording user or equipment problem details.
Evaluating reoccurring problems on same equipment or with same users. 
Providing solutions to problems, either over the phone or by delegating the problem to a third party support area. 
Tracking the progress of resolution to a problem by analysing the status of outstanding problems. 
Making recommendations for areas that will improve effectiveness and efficiency, such as user training, equipment upgrades, and configuration changes. 
Preparing periodic reports outlining support issues for department or company management.

Who are Clients?
A client can be identified as any person or body that requires support or assistance with their computer network (hardware and software) and can include:

Customers
Internal departments
External companies 
Staff members 

Probably the most important aspect to be kept in mind is the fact that regardless of whether the client is internal or external, a support requirement will in most cases lead to a reduction in the ability for them to complete their own tasks and/or jobs.  Hence, supports issues, no matter how small, can have a massive effective on the workplace of the client.



[bookmark: _Toc309477039][bookmark: _Toc321930036]Identifying Support Requirements
The task of supplying comprehensive support processes to the users of a company computer network is not a cheap one.  In an effort to ensure that this process is completed as effectively as possible, great care should be given to the development of comprehensive support plans and procedures.  In most cases, these plans include the following steps:

Identifying the needs of the client
Confirming the responsibilities of the support area
Establishing service level agreements
Setting up problem resolutions paths
Acquiring appropriate support information

[bookmark: _Toc205547460]Client Needs
The first and essential process of any support area is to obtain and maintain an understanding of the needs of their clients.  Client needs can greatly vary and are affected by such influences as deadlines and manufacturing requirements and failure to identify these needs can result in an inappropriate level of support being offered.  The establishment of client needs can be undertaken by completing two analysis steps.

Physical Network Setup

The first step is to identify the physical aspect of the network to be supported.  This will allow you to identify just now many pieces of equipment, software programs and users that you may need to support.  From here, it can quite obviously be assumed that the larger the number of ‘workstations’, the higher the support requirements may be.  In this step, you will commonly check:

Number of staff requiring support.
Number of workstations.
Hardware in use including:
· Peripherals and non-computer hardware.
· Brands, models and other asset details.
Software installed and in use.
Maintenance processes currently undertaken.


To assist with the gathering of some of this information, some IT departments implement systems software audit programs such as Belarc Advisor.  These programs perform an audit of your system to gain network details such as:

Installed software and hardware.
Missing fixes, services packs and patches etc.
Current status of anti-virus software.
Security settings and risks.

Criticality of Client Processes

This is where is can get tricky.  Analysis of a task’s criticality involves an identification process into just how important it is to the workplace.  We do not mean that all jobs within a workplace are not important, but are simply attempting to measure the consequences should one not be able to be completed as required.  

When undertaking this analysis, the following questions can be considered:

Is the task of critical financial importance to the company?
Does one task rely on another I.e. the first task in a chain?
Is the task high profile?
Does the support issue create an OH&S hazard?
Are a large number of users affected?
Is there a workaround?

One useful research tool is the Disaster Recovery Plan (DRP) for the client. The purpose of a DRP is to adequately prepare the network to deal with network ‘disasters’ such system crashes, virus infections, intrusions or component breakdown (hard drive etc.).  As far as system support is concerned, a DRP will outline exactly how long the client can be without a piece of hardware or software before it starts to cost them money. 


Exercise 1
For this exercise, assume that you have been tasked with undertaking the relevant analysis steps to identify the support requirements of the workplace (or one section of a large workplace).

· Create a list of the tasks that are undertaken within this workplace/section.
	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	



· 
Complete an analysis of the physical setup of your workplace/section.
	Number of staff requiring support

	

	Number of workstations

	

	Hardware in use

	

	

	

	

	

	

	

	

	Software installed and in use (maybe run some audit software).

	

	

	

	

	

	

	Maintenance processes currently undertaken

	

	

	

	

	

	

	



· 
Analyse the tasks that you listed in the first part of this exercise in an attempt to identify a potential priority of customer support needs.
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Identifying Support Environments
In the previous section, we discussed the analysis of client needs by identifying the physical set out of their IT environment.  Once we know exactly what we are dealing with, the next step is to work out what we need to do with it in the case of a support issue being raised.  This involves breaking down the components of the network and identifying potential issues that may arise.  The information on the following pages outlines some examples of the components that may be evident and some of the problems that may be experienced.
Operating Systems
The computer operating system is the platform software that interfaces each piece of hardware to the software applications you want to run.  All individual pieces of software that you use (Microsoft Word, MYOB etc.) cannot run unless they are able to sit and run as part of the operating system.  The operating system can perform the following functions:

Perform common hardware functions.
Provide a user interface (often known as the ‘desktop’).
Provide hardware independence.
Manage system memory.
Manage processing.
Control access to system resources.
Manage files.
Accept keyboard input.
Store data on disks.
Send data to output devices. 
Command-based interfaces.

Common computer operating systems are:

	Windows 7
	Windows 7 replaces all earlier versions of Windows and is an incremental upgrade to Vista, with fewer changes than the leap from XP to Vista. It has addressed many of the criticisms of Windows Vista.
New features include advances in touch screen capabilities and handwriting recognition, support for virtual hard disks, improved performance on multi-core processors, and improved speed and security.

	Novel
	Novell Inc. is responsible for the NetWare® operating system. Novel Netware is a windows based operating system that incorporates most of the functionality of its Microsoft competitors. 




	Unix
	The UNIX computer operating system from Bell Labs is still regarded as one of the most powerful, versatile, and flexible operating systems (OS) in the computer world. Its popularity is due to many factors, including its ability to run a wide variety of machines.

	Mac OS
	The operating system for Apple Macintosh systems, MAC OS is a ‘windows’ type system (Apple actually invented Graphic User Interface software) similar to Microsoft windows products.

	Windows XP
	An upgrade from Windows 2000, Windows XP integrates all of the security and networking capabilities of Windows 2000 with some more user friendly functionality added.  

	Windows Vista
	Windows Vista replaces all earlier versions of Windows and like Windows XP etc., is the control centre of the PC.  Windows Vista incorporates current processes such as internet securities, ‘plug and play’ and multimedia programs as well as new functionalities.



Problem Examples

When dealing with computer operating systems, you will often need to undertake some extra analysis to determine whether the problem is with the actual operating system or the components within it.  For example, slow network communications may seem to be an operating system problem.  However it could be a problem with the server, network card or cabling.  Some common problems that may arise with the use of computer operating systems include:

Network logon problems.
Component configuration issues.
Start-up failures. 
Software corruption.
[bookmark: _Toc238300301]
Application Software
Application software is the software that performs many of the functions that users require on a PC.  Applications such as Microsoft Word (word processing), Microsoft Excel (spreadsheeting), Adobe Photoshop (graphics) and MYOB (financial processing) perform the major functionality of a computer system.  Application software can be sold individually (such as Microsoft Word) or as part of a suite (Microsoft Office 2010).

There are also other types of less noticeable application software programs on many network computer systems such as embedded software and drivers.  This is the software that is used to manage and run additional hardware peripherals (printers, smartphones and cameras etc.).  Operating system software does not contain the functionality to undertake the viewing of graphics files or playing music.  To do this, you will require some application software to be utilised. 

[bookmark: _Toc238300302]Maintenance Software
The third main type of software that is loaded onto a computer network is maintenance software.  Maintenance software is effectively application software whose main purpose is to perform preventative maintenance, diagnosis and fault resolutions procedures for other software programs and the network hardware components.  Common types of maintenance software include:

	Anti-Virus software
	There are many different types of antivirus software available for purchase or download that will provide adequate protection for computer networks.  Antivirus software is a program that helps protect a computer against most malware such as viruses, worms, Trojan horses and other unwanted invaders that can severely damage computer software.  
Examples include Norton and McAfee.

	Firewalls
	A  Firewall is a software program that sits between the internet and a private network and works as a barrier to keep destructive viruses away from a computer.  The purpose is to prevent unauthorised access into the company by outsiders.  Data can only travel from the Internet to the network through the firewall.  The software can be configured to accept links only from trusted sites.




	
Diagnostic software
	Diagnostic software programs monitor and analyse the "vital signs" of various parts of a computer such as processor, hard drive and memory.  Most common diagnostic programs, such as Norton Utilities, perform the following functions
Diagnose and fix computer problems. 
Quickly and permanently removes unwanted Internet clutter, temporary files, and other private information about Internet activity
Allows the user to easily see which software processes are running on the computer system, and which ones are affecting its overall performance
System Optimizer—controls access to Windows settings
Perform physical examinations of the PC’s hardware to determine its stability and capability

Microsoft Operating Systems also contain a number of inbuilt maintenance programs including:

Check Disk
Disk Defrag
Disk Cleanup
System Properties (Hardware checks)
Task Manager (System performance)



Problem Examples
As it is with computer operating systems, problems with application software also require analysis to ensure that it is at fault.  A common example is the failure of the software to print an invoice.  This could be the fault of the printer (hardware) or even a configuration problem within the operating system.  Common software application faults include:

Failure to start up (could be operating system).
Software “freezing”
Incompatibility with other programs
Out of date functionalities or drivers (upgrade required)
File output problems


Exercise 2
Discuss the current support processes that you are aware of within your workplace.
	

	

	

	

	

	

	

	

	

	

	

	



Create a list of clients that require support in your workplace.  Discuss your findings with your group/supervisor.
	

	

	

	

	

	

	

	

	

	

	

	

	





Create a worksheet that could be utilised to undertake a client analysis in an attempt to identify their IT support needs.

	




Use this worksheet and record the support needs of a selected client within your workplace.
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[bookmark: _Toc321930038]Service Level Agreements 
As stated, it is an important task of any support area to gain an understanding of the needs of their clients.  It is just as important however, that the requirements of the support area are also accounted for.  For example, it may not be feasible or possible to load new software onto a client’s hardware within an hour of purchase regardless of their needs.

In an effort to standardise agreements, many companies and support areas will setup Service Level Agreements (SLA’s) to incorporate the needs and expectations of both the client and support area.  A SLA quite simply defines the parameters for the delivery of support to the client, for the benefit of both parties.   A SLA will incorporate the following:

Identify the systems and hardware supported
Identify roles and specify responsibilities of service providers who support users 
Detail problem resolution paths for users and service providers. 
Describe service levels users should experience when problems or questions arise

[bookmark: _Toc41696918]Systems and Hardware Supported
The exact systems and software to be supported should be recorded within the SLA.  This should include:

All hardware to be supported (including peripherals)
All software loaded
Warranty and repair/maintenance agreements
Hardware and software license register details and locations
Hardware, software and functions that are NOT covered (the use of illegal software for example)

Note:  SLAs should also contain clauses to cover the possibility of work performed outside the defined service agreement and how it can or cannot be supported.
[bookmark: _Toc41696919]
[bookmark: _Toc41696920]Personnel Roles and Responsibilities
For a SLA to be effective and efficient it is important for all parties involved to know who to contact for each specific operation, how to contact them and if possible, ‘backup’ contacts in case the primary respondent is unavailable. 



Support staff should also be fully aware of their support base and requirements by keeping abreast of:

Who their clients are
What their daily tasks entail
What hardware and software they use
Security and file access structures of the supported computer network
Current hardware and software trends, patches and upgrade availabilities 

[bookmark: _Toc41696921]Problem Resolution Paths
A problem resolution path identifies where and when a problem is ‘escalated’ once a support request is received. This path numbers the steps, in order, and identifies the service providers who will respond to each type of service request.  In most cases, the resolution path will be determined by levels or steps.  Problems are transferred through these steps based on issues such as problem severity, time taken to resolve or whether fault is of critical nature.

An example of common SLA escalation levels are as follows:
[bookmark: _Toc41696923]
	LEVEL1

	Initial contact with support area is made
Client details are recorded and Job is raised (job number given to client)
Details of fault/problem are determined
Potential fixes are researched via knowledge base (support manuals, online help and support pages etc.)
Problem is resolved or escalated to Level 2


	[bookmark: _Toc41696924]LEVEL2

	Job details are updated
Further research is undertaken by technical expert 
Internal documentation is updated and resolution entered into support journal if applicable
Problem is resolved or escalated to Level 3


	[bookmark: _Toc41696925]LEVEL3

	Job details are updated
Problem details are referred to manufacturer or external expert 
Internal documentation is updated and resolution entered into support journal if applicable
Problem is resolved







Problem Severity
Part of the SLA agreement is the severity level appointed at the time of escalation.  This severity level will determine the timeframes that are considered by the support area and client to be acceptable for the resolution of the issue.  Common severity levels are as follows:


	Sev 1
	1 hour resolution time
	Workplace critical errors that cause total downtime such as:
Server crashes
Factory equipment shutdowns
Loss of communications

	Sev 2
	2- 4 hours resolution time
	Workstation critical errors that cause downtime to individual users such as:
Workstation crashes
Malfunction of critical hardware such as CPU or fan
Loss of communications – single workstation
Malfunction of  major software program

	Sev 3
	1 day resolution time
	Workstation errors that do not cause major downtime
Malfunction of non-critical software such as email
Malfunction of non-critical hardware such as printers
Assistance with software operation
Password resets (always a contentious issue)

	Sev 4
	2 day resolution time
	Minor workstation annoyances and requests
Software installations and upgrades
Software resolution tools such as macro and template creation
Hardware swaps
Hardware upgrades






Exercise 3
Outline any SLA agreements in your workplace.  If none, list items as below:
	Systems and Hardware Supported

	

	

	

	Personnel Roles and Responsibilities

	

	

	

	Problem Resolution Paths

	

	

	

	Escalation Guidelines

	

	

	




Outline any SLA severity agreements in your workplace.  
	Sev 1

	

	

	

	Sev 2

	

	

	

	Sev 3

	

	

	

	Sev 4
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The initial client contact stage is probably the most important aspect of the support process as it is here that the details of the fault are first received and analysed.   It is critical that all details are logged quickly and effectively to ensure that the correct solution can be found in the shortest possible timeframe and within the requirements as set out within the SLA.

Phone Contact
If the initial contact with the client is over the phone, it is critical that the call is handled appropriately and professionally to ensure that the issue can be resolved as quickly as possible.  The following aspects should be considered when providing support to clients over the phone:

	Be Prepared
	Be prepared to answer the call by ensuring that all requirements such as pen and paper, support manuals etc. are at ready for use.  Ensure that if support software is to be utilised that it is logged in and loaded to the correct page.  

	Answering the Phone
	Answer the call promptly, calmly and professionally using an appropriate greeting that identifies immediately to the caller who they have called.  For example:  “Good Afternoon, welcome to the IT support desk, this is John.”  

	Handling the call
	Remain calm at all times during the call, especially if the client is stressed or upset at their problem.  Communicate clearly and explain in detail every process that is being undertaken to resolve the problem.  Take ownership of the call and ensure that the client understands the resolution process being outlined to them.

	Ending the call
	Confirm that the client knows and understands the next steps to be taken if any and clarify the major points.  Explain the escalation process if applicable including proposed timeframes for solution.  


	After the call
	Ensure that all call information has been recorded and passed to the second level support areas as required.  Keep the client updated with the resolution process whenever new information becomes available. 




Whether initial contact is made by phone or email, the following flow chart outlines the common steps undertaken when providing support and advice to clients:

Implement a resolution process
Record the support details
Clarify the support requirement
Identify the Client






























[bookmark: _Toc321930040]Client Identification
As previously stated within this manual, different clients have different requirements when it comes to their support needs.  The correct identification of client details will allow for all resolution processes to be undertaken within their needs and more importantly, within the boundaries set by the Service Level Agreement.

Many support areas will implement a support tool outlining the information that is required from the client at the initial point of contact.  The information required by the support tool should include:

	Client Details
	Client Name
Contact Details
Physical Location

	Equipment/software details
	Asset or ID Number
Version of Operating System (Windows 7)
Application running at time of problem
Physical Location of equipment
Warranty or other support conditions
Number of users affected


Exercise 4
Discuss with your group/supervisor the client identification processes undertaken within your workplace.  What information is required?
	

	

	

	

	

	

	

	

	



Create a worksheet that could be utilised to record initial support requirements within your workplace.  Discuss your worksheet with your group/supervisor.
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Once the details and support issues have been received and noted, it is important that the information given is clarified and confirmed prior to escalation or resolution.  Many clients will explain problem symptoms as they appear not how they actually are and will not readily be able to identify hardware components.  The fact that their “screen does not work” is often the only information that they will volunteer.

Clarifying information
Words such as ‘broken’, inconvenient’, ‘complicated’, ‘not working’ and ‘bad quality’ can mean different things to different people.   For example, if a client complains that a piece of software is ‘hard’ to use, it needs to determined exactly what it is that they mean by ‘hard’.    What is it they are trying to do?  Is it the software itself, or the computer they are using?  It may be that they are using a faulty mouse and are finding it difficult to move around, or they may need to attend a training course. 

Simple language should always be used to make sure that the client understands exactly what is meant.
Controlling the Call
One of the easiest ways to quickly and effectively seek information from the client is to control the call.  When a call is being controlled, the client will only talk when answering questions put to them, allowing information to be gathered in a quick, efficient and professional manner.  Controlling the call can assist in many ways, including:

Keeping call times down
Efficient extraction of information
Calming upset and aggressive customers
Maintaining a professional customer service image

Fortunately, the nature of support calls makes the art of call control quite effective as most support conversations start with closed, pointed questions attempting to establish client details (support software greatly assists with the process).  This is the most critical part of the call as it can perform the following functions: 

It will ‘train’ the client to answer your questions without interruptions  
If the client is angry or upset, closed questioning will allow information to be gathered from them quickly without them getting more upset  
Time will not be wasted on irrelevant or idle chatter without it seeming impersonal to the client

Many client support areas implement the closed, open, closed philosophy of call control.  The process is quite simple but can be extremely effective in quickly gathering enough information to make an informed decision as to the problem resolution process.  This process works as follows:

	Closed
	Closed questions are asked from the outset to gather initial identification information:
What is your name?
What is your contact phone number?
What is the equipment serial number?

	Open
	Once this information has been gathered, an open question can start the problem identification process:
What are you having problem with?
What is it that is not working?

	Closed 
	Once basic information has been given by the client, a return to closed questioning will allow for further information to be gathered without the client having to decipher hardware terminologies:
Is there a light on the monitor screen?
What colour is the light on the monitor screen?
Did it make a sound before it went blank?

These questions are much more effective than simply asking “what is the monitor doing?”



Another important part of the call controlling process is to ensure that active listening skills are utilised at all times.  One common error made by support personnel is that they have often made up their mind as to the problem without actually listening to what the client is saying.

Active listening is a structured form of listening and responding that focuses the attention on the speaker. The support operator must take care to attend to the client fully, and then repeats, in their own words, what he or she thinks the client has said.  This enables the client to clarify any points that have not been understood. 



Barriers to listening
Do not read emails or other materials whilst someone else is talking to you.  You cannot concentrate on the two at once.
Do not mentally argue with the person speaking.  Wait until they have completed their statement before passing judgement on their opinions.
Don’t make judgements based on your own opinions of the user’s abilities or knowledge.
Don’t let your eyes wander or your head turn aimlessly about. Keep from drumming your fingers or aimlessly handling pens and so on –focus and cut down distractions.
The burden of listening is on the listener. Don’t automatically condemn a caller or the subject as uninteresting. Don’t prejudice your listening because you don’t like the customer’s looks, voice, etc.
Don’t pretend to be receiving the message while your mind has made a detour and is busy with other ideas.
Whatever you feel about the subject or caller, hear them out first.
Don’t only jot down the highlights or key ideas but pay more attention to hearing the message than to writing everything down.
Don’t waste listening time. The average speaking rate is about 125 words a minute. Your capacity to listen is about 400-600 words per minute. Therefore, while you are listening, you have about 75% of your time free to improve your understanding of what is being said by thinking up answers, make decisions, and plan suggestions.



Exercise 5
Create a script or worksheet containing closed questions that could be utilised to record initial support requirements within your workplace.  Discuss your worksheet with your group/supervisor.

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	


[bookmark: _Toc321930042]Record the Support Information
An integral part of the support process is ensuring that all information regarding the client issue is recorded as clearly and accurately as possible.  Clear, concise recording of support information not only assists second level support areas to resolve the problem quickly, but can also be utilised to build a solutions database for future problem resolutions.
Support Software
An effective tool implemented in many workplaces to assist with the documentation of incoming support issues is a designated support software program.  Whether ‘off the shelf’ or purpose built, support software programs can be extremely useful in the recording of support requirements.

The main advantage of support software is that it can lead the user through the information gathering process as they move from one field to the next whilst on the call.  The information requested and entered can then be analysed by the system to automatically designate escalation and severity levels consistent with the SLA.

Other advantages can include:

Updates, solutions and follow-ups can be fully documented in a central environment
A database of problems can be built allowing for the research of previous and continuing occurrences of problems and support issues
A knowledge base of solutions can be built to assist with resolution and training processes
Monthly reports can be generated to assist with monthly maintenance, training and costing processes
[image: ]
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Exercise 6
What information regarding client support and advice requirements is recorded within your workplace?  Discuss your findings with your group/supervisor.
	

	

	

	

	

	

	

	

	

	

	

	

	

	


Are any support software programs in use in your workplace?  How is this software utilised in the support processes of your workplace?
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Implement a Solution
Once the call information has been received and clarified, a solution process will need to be implemented.  At the initial contact stage, a solution may not necessarily mean a total resolution to the issue.  Solutions can be:

Resolution of problem at first level
Escalation of problem to a second level

First Level Resolution
Most problems that are solved at the first level of support are usually solved as part of the problem determination process.  These resolutions may be along the lines of reconnecting a cable, offering instruction for a software function or explaining the reason for an outage.  Whenever a support issue is solved at the initial call, the following steps should be undertaken:

Record all details of the issue, diagnosis process and resolution in the support journal or software
Obtain confirmation from the client that the problem is resolved to their satisfaction
Send backup user documentation such as instruction or troubleshooting guides to the client as applicable
Complete reporting processes as applicable and close support log
 
One major issue in many support areas is that ‘simple’ issues are not recorded or reported as required due to the ease of resolution.  The issue here is that although the problem is only small and easy to fix, a support area can receive multiple calls for the same fault every day.  These calls can then clog up support avenues for larger, more critical problems.  Proper recording and analysis of these issues can:

Lead to the creation of long term solutions significantly reducing the number of nuisance type calls
Identify trends that may be a sign of larger problems e.g. many users suffering network connection problems



Second Level Resolution
In most companies, whenever a problem or issue cannot be resolved during the initial contact, it is escalated to a second level support area.  Second level support areas will usually:

Respond to support issues according the SLA timeframes and severity level requirements
Undertake more in-depth research
Consist of support staff with more experience/knowledge
Contact vendors and manufacturers if required

Depending on company protocols, second level support areas will provide solutions directly to the client or via the first level contact area.  
Exercise 7
Outline the first level resolution processes undertaken within your workplace.  Share your findings with your supervisor/group.
	

	

	

	

	

	

	

	

	

	

	

	

	

	





What processes are undertaken in your workplace to provide long term solutions for small or nuisance support issues?
	

	

	

	

	

	

	

	

	

	

	

	


Outline the second level resolution processes undertaken within your workplace.  Share your findings with your supervisor/group.
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Once the initial details of the issue have been received and recorded, the problem resolution process is then undertaken as per SLA guidelines.  Normal investigation paths can include:

Investigating previous occurrences
Locating relevant documentation
Undertaking other investigation processes
Resolution processes instigated
Journal and User documentation creation

[bookmark: _Toc321930045]Previous Occurrences
As each issue has been determined and confirmed, the first step normally undertaken in the investigation process is to determine whether this problem has arisen prior to this occasion.  Previous occurrences can normally be located by interrogating

Support software
Maintenance journals
Resolution notes
Team meeting notes

In the case of repeat issues, the following areas need to be investigated:

Is it the same terminal?
Did the last resolution really fix the problem?
Can the problem be reproduced on other machines?
Would an assistance tool such as a macro or template solve the issue?
Is a training intervention required?

If the problem has been experienced previously but on a different terminal or by a different user, the following steps should to undertaken:

	Problem resolution
	As the problem has occurred previously, locating the problem solution can save investigation and research time for the support area and minimise downtime for the user.  It is important to check however that once the resolution process has been completed, that the problem has been resolved.  What works on one machine, may not necessarily always work on another. 




	Identification of ongoing issues
	If a number of previous occurrences are evident but are occurring on different terminals, this information may then be used to instigate further investigation into the causes of the problem.   This can be performed by contacting the manufacturers or researching web support sites where permanent solutions can be realised by downloading patches, upgrades or following re-configuration instructions etc.

	Identification of potential substandard hardware or software user issues
	Further investigation into recurring hardware errors may also reveal inadequacies or malfunctions due to substandard hardware components.  Manufacturer website and support areas may have more information regarding known hardware issues and can even provide replacement/warranty information.
Continuous support calls relating to the completion of certain software tasks may require a training intervention in a one on one or group session that may be delivered in-house or off site.

	Distribution of help materials to users
	Once the research processes have been completed and a known solution sourced, it is important that effected users are notified of the issue and any potential ramifications to them.  Users may need to be informed of:
Problem causes and avoidance processes 
User level resolutions if problem arises
Update or upgrade schedules
Hardware replacement processes



Exercise 8
Is there anywhere within your workplace where information on previous problem occurrences can be located?  Discuss with your supervisor.
	

	

	

	

	

	

	

	

	

	



Discuss with your group/supervisor any support issues that have reoccurred within your workplace.
	

	

	

	

	

	

	

	

	

	

	

	

	

	



What processes have been undertaken in an effort to reduce or eliminate reoccurrences in the future?
	

	

	

	

	

	

	

	

	

	

	

	

	

	



Outline how the following steps are undertaken in your workplace.  Discuss your findings with your group/supervisor.

	Problem resolution

	

	

	

	

	

	

	Identification of ongoing issues

	

	

	

	

	

	

	

	Identification of potential substandard hardware or software

	

	

	

	

	

	

	

	Distribution of help materials to users

	

	

	

	

	

	

	



[bookmark: _Toc321930046]
Locating Documentation
One of the golden rules of any support area is that “you do not have to know everything, just where to find it”.  No one person can possibly know the solutions to every problem that is reported by a user in the workplace.  The trick is to build a library of manuals, support journals and website lists that can be utilised to find solutions to problems as they arise.

Support documentation can be found in many locations including:

Vendor’s websites
Manufacturer’s manuals and websites
Company procedures manuals
Industry publications and websites
IT Websites and blog sites
Software training manuals
Troubleshooting guides

Many manufacturer and vendor websites contain support links that allow for questions and support issues to be directed directly to their own support areas.  Many also contain information sharing areas where ideas and resolution requests can be discussed.

Exercise 9

Create a list of document locations available within your workplace.
	

	

	

	

	

	

	

	

	

	

	

	

	

	


With your group/supervisor, log in to the websites of some of your manufacturers or vendors and locate (if available) any support services/ areas offered.  How can there areas be of assistance within your workplace?
	

	

	

	

	

	

	

	

	

	

	

	

	

	



Undertake some searches on the internet.  What other helpful support sites can you find?  Discuss with your supervisor what precautions might need to be undertaken prior to utilising information on some of these sites.
	

	

	

	

	

	

	

	

	

	

	

	

	

	



[bookmark: _Toc321930047]
Other Investigation Processes
If the support requirement has not been previously reported and/or the appropriate support documentation cannot be located, it will be necessary to perform other investigation processes to determine the correct solution path required.  There are a number of tests that can be undertaken to identify problems and malfunctions within hardware components and software programs.  These tests can include:

Basic system software diagnostic tests
Hardware tests such as cable connection and printer test page requests

These tests can be performed quickly and are often able to be undertaken by the client over the phone with instruction from the support area.  Often however, problems identified by these tests will require an equipment swap or software reload which may require offsite resolution.

[bookmark: _Toc204082355]Diagnostic Checks
Diagnostic tools are software programs that allow the user to internally check hardware and software processes of the network system.  Operating systems such as Windows 7 contain in built diagnostic tools that allow the user to perform basic system checks.  

Refer to your IT Manager or the Microsoft Website for more information in regards to diagnostic software.




To perform checks via the Windows 7 Operating System:

· Click [image: ], then select Control Panel.
[image: ]
· 
Click on [image: ]from the System and Security option.
[image: ]
· 

· Double click on the device to be checked.
[image: ]
If the computer Operating System can 'see' the device and there are no conflicts, it will show as per above.  If not, it may have lost power or not be seated within the motherboard correctly.


If, after these basic diagnostic checks, the device in question cannot be viewed by the operating system, further intervention will be required as per company and SLA processes.


Hardware Tests
Should the issue reported be a case of the piece of equipment simply not working, there are a few common checks that can be undertaken prior to escalation of the issue.  These tests are performed at first contact with the client or at a time suitable to them.

One critical point to be aware of at this time is that many clients do not understand computer technological terms or jargon.  It is important that the language used at this stage is clear and in terms that can be understood by the client.

Cabling

One common problem that occurs in many workstations is that cables can become loose and/or be knocked out of their sockets.  The client will need to be walked through not only checking that cabling is plugged in, but whether it is properly connected/seated.  At this point, it is also important to ensure that appropriate questioning is used to ensure that checks are completed properly.

For example, if a computer CPU is moved, the monitor cable may become unseated from the video connection without actually becoming fully disconnected.  When asked if the plug is still connected, the client will most likely answer “yes” even though it is not properly seated.  They will have to be prompted to actually push the plug into the socket to ensure it is in fact seated correctly.

Hardware Tests

Some hardware components have inbuilt tests that allow them to be checked for problems.   Manufacturer and Vendor manuals, checklists and online documentation can also contain useful checks that can be undertaken at the initial support level should problems arise.

For example, most printers contain functionality that allows them to print a test page that ensures that the printer is connected and print heads are aligned.  Other simple tests can include:

Placing a CD or DVD in the DVD drive to see if it can read the contents (always try more than one!!)
Inserting another mouse, keyboard or other USB device into the same USB port to test if problem is with the device or port 


It is important to remember however, that all client level checks must be completed within company, OH&S and SLA guidelines and with the full agreement of the client.  Some people do not feel comfortable ‘fiddling’ with cabling etc. and will possibly not give accurate answers to questions asked.


Additional Requirements
There are times when during the problem diagnosis process that other errors or requirements will become evident.  Common occurrences are:

The location of other devices that are not working properly
Training needs identified
Documentation needs identified
The need for extra tools such as template, macros or software 
plug-ins identified

In most cases, a separate job will need to be raised and escalated if necessary via the appropriate channels.  All details will need to be recorded on the support software program if applicable.

Recording Problem Details
Prior to the resolution process being undertaken, it is extremely important that all details of the problem determination process are recorded.  The recording of these details not only gives the escalation support point a full account of the problem, but allows for a problem database to be built for use in the case of future occurrences of the same problem.

The details recorded should not only record the fault, but the steps taken to diagnose or isolate the issue even if there was no result from some steps taken.



Exercise 10
Discuss with your group/supervisor which software diagnostic tools are utilised in your workplace for first level diagnosis of hardware faults and issues.
	

	

	

	

	

	

	

	

	

	

	

	

	

	


Discuss with your group/supervisor some of the common cabling and hardware problems evident within your workplace.  What processes are undertaken to identify the cause of these problems?
	

	

	

	

	

	

	

	

	

	

	

	

	

	



Locate some manufacturer or vendor documentation or websites for some of the hardware in your workplace.  What problem determination checks do they make to suggest if the equipment does not seem to be working? Hint – Look for the troubleshooting section.
	

	

	

	

	

	

	

	

	

	

	

	

	

	



Using the information gathered on the previous page, create a troubleshooting guide that could be utilised within your workplace for determining problem causes at the initial support contact level.
	

	

	

	

	

	

	

	

	

	

	

	

	

	



[bookmark: _Toc321930048]Problem Resolution 
Once the problem diagnosis process has been completed, the required resolution process can be implemented.  In many cases, any issues that can be resolved at user level will be completed during the first contact call.  All other issues will require escalation to other points and the resolution processes undertaken will depend largely on SLA, company resolution policies and manufacturer/vendor agreements.  

[bookmark: _Toc321930049]Hardware Resolutions 
Due to such influences as OH&S policies and vendor agreements, most escalated hardware faults require the equipment to be swapped or removed from the client work area.  In the case of equipment swap, the following points will need to be accounted for:

Hardware should be swapped at a time convenient to the client
In the case of CPU swap, the new hardware should be loaded with a similar build to that currently installed
If spare equipment is not available, alternative arrangements should be made to reduce inconvenience to the client
Client should be fully informed of estimated turnaround times and solution processes
Support software should be updated with all details of escalation and resolution undertakings

It is important to note that vendor and manufacturer requirements need to be noted and strictly followed at this point.  Failure to do so can void warranties and/or service agreements which could prove costly to the company and client.

If the faulty hardware is to be reinstated to the workplace after the resolution process is completed, equipment should be swapped back only at a time which is convenient to the client and within workplace protocols.



Exercise 11
Discuss with your group/supervisor the hardware escalation procedures of your workplace.
	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	





Create a checklist that could be utilised to ensure that all processes are covered when faulty hardware is swapped in your workplace.

	

	

	

	


[bookmark: _Toc321930050]
Software Resolutions 
Software escalations can be a little more complex than hardware faults and may not necessarily require the hardware to be swapped.  Once the issue has been established, it may not always be necessary to ‘fix’ the software as such.  Some common software resolutions can include:

Re-cloning of operating system with company build
Driver reloads 
Loading of software updates, patches or plug-ins 
Training Interventions or software tools for operation difficulties


Ghost or Clone install
In an effort to insure all computers on a network operate the same way, many companies will implement a cloning installation process.  The operating system is installed onto a base machine and loaded with required software and hardware drivers as per a clean install.  Company specific user and security settings are then also configured.   A ‘clone’ of the build is then created and can be loaded onto other machines within the network.  All software, drivers, security and user settings are loaded in the one installation process.  

Many second level support areas have found that it is quicker and more cost effective to simply reload the clone image when there is a fault rather than try to fix individual errors.

Driver Reloads
If the device is not working but can be seen by the computer operating system, the drivers may need to be checked and if necessary, updated.


To reload the driver via the Windows 7 operating system:

· Click [image: ], then select Control Panel.
· Click on [image: ]from the System and Security option.
[image: ]
· 
Double click on the device to be checked.
[image: ]
.
· 
Click on the Drivers tab.
[image: ] 
· Click on the [image: ] button to update the driver as required.
[image: ] 
· Click on Search automatically for updated driver software to locate new drivers for the device.
[image: ] 
If an updated driver is loaded, it can be loaded as per workplace policies.  If not, the following screen will appear.
[image: ]

If the driver is up to date but the device still does not work as expected, then physical hardware resolution processes may be required.

Software patches, Plug-ins or Upgrades
Software manufacturers constantly release patches and updates to their software programs.  These patches/updates are required for many reasons including bug fixes, driver updates to match new operating systems and enhanced feature releases.

Most patches/upgrades are released via internet downloads as executable installation files.  Prior to the installation of any software patches or updates, the following considerations should be taken into account:

	Company Policy
	All software installations must be implemented within company policy guidelines. 

	Run a backup
	Unfortunately, some patches or upgrades can actually cause more problems to the system than they were intended to fix.  A backup will protect sensitive data just in case the update fails and/or corrupts the operating system.

	Security settings
	Ensure that the software download can be performed and is compliant with company security policies.

	Document process
	The entire update and installation should be documented for use in any future problem troubleshooting or diagnostic processes.



Software patches and upgrades should also only be undertaken after hours or at a time when convenient to the client.  


Exercise 12
Discuss with your group/supervisor the use of clone or ghost software in your workplace.
	

	

	

	

	

	

	

	

	

	



What is the process undertaken for the sourcing and installation of software upgrades or patches within your workplace?  Discuss your findings with your group/supervisor.
	

	

	

	

	

	

	

	

	

	





Training Interventions 
Training interventions may be required if the support issue is due to usability problems with the software, not an actual fault.  Training interventions can be undertaken or supported in a classroom or one on one process in the workplace.  

[bookmark: _Toc204412138]If it has been established that the client is in need of training, then the type of training to be undertaken needs to be decided.  In most cases, the issue is escalated to the HR/Training area within the company to organise a training course via an external provider or in house training by internal personnel.

If the training intervention is to be carried out by the support area, the following areas will need to be addressed.

Support Documentation

The first step in any training preparation process is to locate support documentation to assist in the transfer of succinct and accurate information.  Support documentation can be found in many locations including:

Vendor’s websites
Manufacturer’s manuals and websites
Company procedures manuals
Industry publications and websites
IT Websites and blog sites
Software training manuals
Troubleshooting guides


Many manufacturer and vendor websites contain support links that allow for questions and support issues to be directed directly to their own support areas.  Many also contain information sharing areas where ideas and resolution requests can be discussed.

[bookmark: _Toc98686612][bookmark: _Toc204412139]The Delivery Plan

A common tool for the preparation of a training session is to record relevant information onto a delivery plan.  The delivery plan allows the trainer to consider all potentially required aspects of the training program including:

Number of users to be trained
Assessment requirements
Known and possible learning characteristics
Support needs
Delivery methods
Resource availability

Once this information has been gathered, a full training plan can be implemented that includes subject matter to be covered, course timings and resources requirements.
Exercise 13
What are the processes undertaken within your workplace if a training intervention requirement had been determined?  Discuss with your group/supervisor.
	

	

	

	

	

	

	

	

	

	




· How could ongoing training programs assist in the reduction of support requirements within a workplace?
	

	

	

	

	

	

	

	

	

	




[bookmark: _Toc321930051] User Documentation
Part of the on-going support process is the provision of user documentation to the clients.  Supplying clear and accurate user documentation can provide many advantages to support areas and can include:

User Manuals
Training Manuals
On-line help documentation
Self-paced tutorials
Quick reference guides
Brochures
Project Specifications
Upgrades advices and outlines

As stated, the provision of user documentation can provide many advantages to a support role.  Not only can it be used to source and provide a solution to client issues, it can be utilised as an ongoing reference and training tool for the client.  

Quick reference guides and brochures can also be distributed proactively for more common issues that have become apparent in the review and feedback processes (see later in this manual).  This process allows users to help themselves freeing up support areas to assist more critical faults and problems.

If current user documentation is not available, it may become a task of the support area to create and distribute materials to meet the requirements of the client.  The following pages outline the processes involved in the creation of user documentation for support purposes.

[bookmark: _Toc202779324]Document Purpose
We have already discussed the number and types of user documentation that is available.  Prior to any design and creation steps being undertaken, it is important to gain an understanding of exactly what it is that the document is trying to achieve.  

Determine whether the document is to meet such purposes as training, advice, instructions for software updates or to outline specifications and business processes for a certain project.



The following checklist could be utilised to assist in the document analysis process

	Project name:
	
	

	Project Purpose:
	
	

	Documentation:
	

	Purpose?
	

	
	

	Reasons?
	

	
	

	Proposed Users:
	

	Current knowledge of the program
	

	Level of knowledge required
	

	Amount of time available to work with User documentation
	

	Access to documentation
	

	Motivation to utilise documentation
	

	Other Potential barriers?
	

	
	



[bookmark: _Toc202779325]
System/Software
The next step is to undertake an audit of the system/software to ensure that all requirements and relevant functionalities have been taken into account.  This process may require some research to be completed and will need to incorporate industry standards and well as company policies and protocols.

Depending on the software and how it was created/implemented, the required information may be located in some of the following locations:

Existing user documentation
Software technical documentation
Internet sites, blogs or user groups
Technical specs if software custom built
Company training manuals

It is at this point that extra functionality may be discovered and added to the documentation to increase its worth and importance to general company users.


Don’t reinvent the wheel

Always check to see whether the current documentation being used as part of the software analysis could be utilised to meet current needs.  Why recreate something that is already there? 

[bookmark: _Toc202779326]Industry Standards
Another critical aspect of the analysis process is whether the document meets current industry standards.  Industry standards are a broad range of internal and external policies that are incorporated to ensure that companies meet regulations such as guidelines such as OH&S, fair trading and Health regulations.  They affect operations undertaken in most workplaces including manufacture, repair and distribution.  

For example, an electrician is required to install a light fitting to Australian Standards for electrical work.  Hence, by law, any user documentation for this process will need to incorporate these standards.  

Information on industry standards within a workplace can be located in areas such as:

Company Procedures Manuals
Project Specifications
Websites – (such as www.standards.org.au)
Industry Publications
Company Management

Exercise 14
Discuss the types of user documentation that is available within your workplace. 
	

	

	

	

	

	

	

	

	


Discuss with your group/supervisor, any industry standards relevant to your workplace.
	

	

	

	

	

	

	

	

	


Where can information regarding these standards be located?
	

	

	

	

	

	

	

	





Locate a piece of user documentation from your workplace (or an example of some from elsewhere if not possible) and analyse the following:
	Document purpose

	

	

	

	

	

	

	

	System/software functionalities

	

	

	

	

	

	

	

	Industry Standards

	

	

	

	

	

	

	

	

	


[bookmark: _Toc202779327]
Target Audience
As previously stated, it is important that any user documentation created is able to be understood by the intended audience and meet their needs.   An analysis of audience capabilities will greatly influence the type of documentation created as well as the depth of information required.  It is also at this point that the information gathered from the previous analysis steps can be further enhanced.

Comprehensive knowledge of the target audience will not only assist in choosing the type of documentation required in the design process, but can also be used to identify any other potential development needs within the workplace.
 
Depending on the intended audience, this process can be carried out in a number of ways:

Questionnaire for target users to complete
Peer/Supervisor checklist
Observation
Analysis of current outputs/results


The following checklist could be utilised to assist in the identification of target audience characteristics:

	User name:
	

	Role:
	

	Experience in role:
	

	
	

	Computer Literacy
	High			Medium		Low

	Envisaged need of proposed documentation:
	

	Access to current information:


	



[bookmark: _Toc202779329] 
[bookmark: _Toc321930052]Design
Once the information gathered has been analysed and quantified, the design process can be undertaken.  The first step is to decide what type of documentation is required and how it will be created.

The type chosen will depend largely on the purpose, outcome and audience requirements as outlined in the Analysis stage but there may be other factors to consider.  Other influences such as company policies, available authoring tools and security concerns can also affect the type of documentation that is created.

The following table may also assist in the decision making process:

	Type of Documentation
	Advantages
	Disadvantages

	User Manuals
	Comprehensive.
Can cover business and software processes.
	Can be too technical for some users.
Information cannot always be found quickly.

	Training Manuals
	Can cover business and software processes.
Can contain step by step instructions to assist users.
Can contain exercises for off-line practice.
	Can be time consuming to complete.
May need sample exercise files.

	On-line help documentation
	Information can be quickly located and found ‘real time’.
Can include animated demonstrations.
Can be linked to external information sources thus saving build time.
	May need extra software or permissions to work on all PCs.
Users need to be more computer literate or in the system to utilise.
Creation process can be costly.

	Quick reference guides
	Information can be quickly found and followed.
Can be built for most common processes.
Usually single page so can be quickly created.

	Difficult to ensure all users have most up to date copies if changes are made. 





	Brochures
	Information can be quickly found and followed.
Can be built for most common processes.
Usually single page so can be quickly created.
Usually a more colourful look to grab user’s attention.
	Difficult to ensure all users have most up to date copies if changes are made. 
Software and printing can be costly.

	Presentations (PowerPoint)
	Can cover multiple users at one time.
Can be made more interactive to engage user.
	Users cannot always refer back to slides when actually performing tasks

	Memos
	Can be quickly created and distributed.
Cost effective.
	Not always read by users.
Likely to be read once then discarded.



Exercise 15
Discuss with your group/supervisor the workability of each documentation type within your workplace.

	Type of Documentation
	Advantages
	Disadvantages

	User Manuals
	
	

	Training Manuals
	
	

	On-line help documentation
	
	

	Quick reference guides
	
	

	Brochures
	
	

	Presentations (PowerPoint)
	
	

	Memos
	
	.



[bookmark: _Toc321930053]Using Software Tools
There may also be times when a client or user is conversant enough with the software to complete daily tasks, but may need some software tools such as templates or macros to be implemented to assist with required processes.  The creation of these tools may be undertaken as part of a training intervention or built as a one off solution.

[bookmark: _Toc362177829][bookmark: _Toc85284558][bookmark: _Toc175047125][bookmark: _Toc177189065]Templates
[bookmark: _Toc362177833][bookmark: _Toc85284564][bookmark: _Toc164255369][bookmark: _Toc175047131][bookmark: _Toc177189071]Templates allow you to save time when working with frequently used documents as you do not have to start them from scratch each time.   The layout, formatting and base text is saved and reused so all you have to do is update any new information.

You can use in-built templates, or create your own. In this exercise we will utilise one of Word’s many templates to create a fax header. 

· Open Microsoft Word 2010.
· Click on the [image: ] button in the Quick Access Toolbar to create a new blank document (which is also a template).
· Click on the File tab then select Open.
· Select the Templates option on the left hand side of the Open dialogue box.



If no templates are displayed, you may need to download some from the Microsoft Website – try http://office.microsoft.com/en-au/templates/ 
[image: ] 


· Double click on Fax.dotx (or one of a similar name).
[image: ]
Let’s now update this template and save it as our own.  
· Click in the From: field and type your name.
· Click in the Phone: field and type your phone number.
· Click in the Comments: field and type: If this fax is unclear, please call me on the number above.
· Click on the File tab and select Save As.


· Change the document name to myfax and ensure that the document type is Word Template.
 [image: ]
· Click on the Save button to save your own template.

Test Your Template
· Click on the File tab then select Open.
· Select the Templates option on the left hand side of the Open dialogue box.
· Double click on myFax.dotx.

There you go!  You will never have to type that information again!



Macros
To speed up the process of accessing our memo, we will record a Macro that creates a new document based on myFax.  In the next exercise we will place this macro as a new icon on a toolbar.

Macros are located in the Developer tab on the Ribbon and as we added this feature to the Ribbon in an earlier session it will be available for you to use.
Ensure that Microsoft Word is open.

· Create a new document.
· Click on the Developer tab and locate the Code group.

[image: ]

· Click on [image: ].

· Type MyMacro as the name for the macro.

[image: ]
[bookmark: _Toc85284566][bookmark: _Toc164255371][bookmark: _Toc175047133][bookmark: _Toc177189073][bookmark: _Toc201473264]
Assigning the Macro to the Quick Access Toolbar
· Click on the Button icon.

[image: ]

The Word Options dialog box is displayed, and the macro name is displayed as text.
[image: C:\Users\T403~1.TRA\AppData\Local\Temp\SNAGHTMLa9123b.PNG]The macro name is displayed as text

· Click on your macro, then click on [image: ],
[image: ]
· Stay in this dialog box for the next exercise.


In the next exercise we will change the text to an icon.

[bookmark: _Toc85284567][bookmark: _Toc164255372][bookmark: _Toc175047134][bookmark: _Toc177189074][bookmark: _Toc201473265][bookmark: _Toc318226671][bookmark: _Toc319755571]Formatting a Macro Icon
· Click on [image: ] in the Word Options dialog box. 
[image: ]
· Choose a different button image.

 [image: ]

· Change the Display name to “Create a Memo”. 

The display name is visible when you point to the icon on the toolbar.


· Click on [image: ] twice.
[image: ]
You are now recording your macro and the Stop Recording button is visible in the Code group. Your mouse pointer changes to a “tape” icon.
[image: ]
Note that you have just created the icon for the macro, but you are yet to create the macro itself. 

[bookmark: _Toc85284568][bookmark: _Toc164255373][bookmark: _Toc175047135][bookmark: _Toc177189075][bookmark: _Toc201473267][bookmark: _Toc318226672][bookmark: _Toc319755572]Recording Macro Actions
To record the steps for the macro:

· Click on the File Tab [image: ]  and choose New.
· Under the Templates section, click on From Existing.
[image: ]
· Click on your myFax template and click on [image: ]
· Press [Ctrl Home]. This action places the cursor at the beginning of the document each time the macro is run.
· From the Ribbon select the Insert tab > Date and Time.
· Insert the current date, but not as a field (do not tick update automatically).


· Click on the Developer tab, and click on [image: ]. 

[image: ]

Your macro has now been created!
[bookmark: _Toc201473268]Testing your Macro
· Click on your new icon in the Quick Access toolbar.
· Answer the prompts!
· Close all open documents without saving.
[bookmark: _Toc85284569][bookmark: _Toc164255374][bookmark: _Toc175047136][bookmark: _Toc177189076][bookmark: _Toc201473269][bookmark: _Toc318226673][bookmark: _Toc319755573]Using the Macros Dialog Box
If you forget what macro is assigned to what icon, you can manually run a macro from the Macros dialog box.
· Click on the Developer tab.
[image: ]
· Click on [image: ].
[image: ]

· Choose MyMacro.
· Click on [image: ].
· Close all open documents without saving.

Exercise 16
Use the instructions on the previous pages to create a template to assist with user requirements within your workplace.

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	


Use the instructions on the previous pages to create a macro to open the template created on the previous page.
	

	

	

	

	

	

	

	

	

	

	

	



Run your macro. Discuss any problems that may have arisen (such as missed steps etc.).
	

	

	

	

	

	

	

	

	

	



[bookmark: _Toc321930054]Client Feedback
As with many other support services, client feedback mechanisms are a good way to ensure that the needs of the client are being covered to their satisfaction.  Obtaining client feedback also allows for the collection of data in other areas including:

Ensuring the provided solutions have solved issue in the long term
Assessment of customer service processes
Training for support staff
Assessment of SLA and severity timeframe accuracy and appropriateness

The most important part of the client feedback process is choosing the most appropriate way to gather the information from the client.  There are numerous methods that can be implemented with the most common being client survey or feedback forms.  Other methods can include:

Verbal Question and Answer
Online questionnaire
Training assessment process
Monitoring of task completion statistics

The next page contains an example of an online support feedback sheet.


[image: ]


[bookmark: _Toc321930055]
Method Analysis
Regardless of the instrument type chosen, the feedback received is only as good as the questions or information asked of the client.  Many support areas will distribute documentation asking for feedback information that does not really allow for an accurate response from the client.  When creating a feedback survey or questionnaire, the following aspects need to be taken into account:

	What is the best method to use?
	The information gathering method chosen needs to be able to extract the required data from the client quickly and effectively.  Clients will not take the time to fill in a form that takes too long to complete, is hard to understand or is does not work properly (electronic forms etc.).  

	What information does it need to gather?
	Feedback analysis needs to be undertaken to ensure that the feedback form gathers useful information.  The support area needs to identify exactly what sort of information it is after so it can build the feedback or survey form accordingly.

	How will it be distributed?
	Unfortunately, the distribution and collection of feedback data can be a timely exercise.  The distribution timeframes and methods need to be clarified and adhered to as much as possible.

	What instructions will be needed?
	Often, the client will need to be instructed on the use of the form.  Instructions can be delivered with the survey or as a general notice prior to commencement of the feedback process.

	How will the data be collected and analysed?
	To be effective, the data collected needs to be effectively recorded for analysis and follow-up.  Feedback data can be used for many functions.  It is imperative that the method created and questions asked are able to supply data that covers as many of these purposes as possible.  

	How will the results be published?
	The easiest way to obtain client input into feedback processes is if they can see a positive outcome from the data that they have supplied.  Ensure that the process used to analyse the data allows for clearly deciphered result to be distributed to clients.


 


Other Factors
It is important to ensure that the survey remains positive.  Name the survey forms ‘feedback forms’, not ‘complaint forms’.  The survey does need to be able to record the bad with the good, but it doesn’t need to push the customer into saying something negative if they were not inclined to do so at first.

Survey and questionnaires can be given to customers in many ways:
With the product
Emailed
Mailed
Left on the counter
Online forms

Look for things like:
A quality rating of your customer service levels
Staff response times
Common complaints
How you can improve
Ease of navigation of support system

Note:  The advantage of an online system is that a survey form can easily be incorporated into the website or online ordering system.  Some sites will even ask clients to complete the survey as part of the support process.  
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 Analysing Feedback
As we have discussed, the purpose of our survey is to gain a tangible measurement in regards to the support processes of the workplace.  Failure to properly analyse the results of the survey will not only render the whole processes useless, but also potentially cause a loss of trust from your clients if they do not see any results of the action.  When analysing the feedback, the following steps can be undertaken. 

Set a benchmark
Try to gather some statistics on previous levels before the survey process is implemented.  Use results from previous surveys, sales figures or return business statistics.  

The information gathered at this point will then be compared to the resulting information from the survey.  Over time, a company should be able to measure the success of current and future communications strategies and systems.

Conduct the survey
Conduct the survey by whichever method decided.  Or alternatively, if an ongoing survey process is setup in an online system, set a timeframe for the data to be collected and analysed.

Decide on a reasonable timeframe for the survey.  If the time is too short, enough information may not be gathered.  If too long, the survey will become stale as communications patterns may have changed due to outside influences such as politics, seasonal patterns and changes to technology.

Record the findings
There are numerous software applications available that are capable of analysing and presenting the results.  Database programs can compare statistics from numerous surveys and spreadsheet programs can visually display the data in the form of charts and graphs (examples on next page).

Use this information to establish what areas the company is excelling in and which areas need improvement.  


[bookmark: _Toc237703552]
Feedback Report
Once areas for improvement have been identified, suggestions and ideas need to be gathered in an effort to improve the service processes as per the customer feedback.  In many cases, this process is undertaken by the writing of a feedback report.  A feedback report should cover all aspects of the feedback process undertaken including:

	Background information
	Introduces the report and outlines the customer service background of the company, any previous survey results and any other relevant information in regards to the customers of the company.

	Aim
	This section should outline the aims and/or reasons for the survey to be completed.  If possible, some background information such as customer complaints or sales figures should be included within this section.

	Who was surveyed?
	Should include:
· Number of customers surveyed
· Percentage of customers surveyed
· Customer demographical information as applicable

	Methods undertaken
	Outline how the methods used to gather the survey results including an example if applicable

	Benchmarks to be measured against
	This can include:
· Statistics on current customer service levels
· Results from last surveys
· Sales figures
· Return business statistics 

	Survey Results 
	This section should comprehensively cover all survey results reported in a manner that can be quickly and easily understood by all readers of the report.
The survey results should also be compared to previous results and benchmarks so a clear understanding of improvement or decline in customer service satisfactions levels can be identified.




	Suggestions
	Suggestions for improvement should be outlined clearly including reasons and planned improvements.  It is important that each suggestion fits within company procedures, policies and legislations.  They should also be achievable and realistic.

	How are we going to do this?
	Outlines how the proposed suggestions would be undertaken.

	
Future plans 
	Should include:
· Timeframes for future surveys
· Checkpoints to be implemented to ensure successful implementation of suggestions
After a designated amount of time, compare sales statistics and/or strike rates to see if the improvements have indeed made a difference.  Or conduct another survey to see if the customer service levels have improved.  


[bookmark: _Toc237703553]

[bookmark: _Toc321930057]Implementing the Change
Once the survey feedback report has been completed and presented to the appropriate personnel, a decision needs to be made as to the implementation of the suggested improvements outlined within the report.  In most cases, these suggestions will be analysed carefully to ensure that the best possible solutions and/or outcomes can be achieved.  Some of the areas that will be considered in this process include:

Costs of implementation.
Adherence to Legislations and company policies.
Likelihood of improvements being realised.
Risks.
Number of staff required to implement changes.

Note:  Be careful not to change for change sake.  The idea of this process is to improve the service and/or processes, not to change the world.  Too much change could actually cause the customer service levels to deteriorate rather than improve. 

Exercise 17

· Discuss the current processes for gathering feedback within your workplace. How is the information managed?
	

	

	

	

	

	

	

	



· Undertake the analysis steps below to identify an appropriate method that could be undertaken to gather effective feedback in regards to the support processes of your workplace.
  
	What is the best method to use?



	

	

	

	

	

	

	

	

	




	
What are the demographics?

	

	

	

	

	

	

	

	

	

	What information does it need to gather?

	

	

	

	

	

	

	

	

	

	How will it be distributed?

	

	

	

	

	

	

	

	

	




	What instructions will be needed?

	

	

	

	

	

	

	

	

	

	How will the data be collected and analysed?

	

	

	

	

	

	

	

	

	

	How will the results be published?

	

	

	

	

	

	

	

	

	



· 
Create a survey/feedback sheet that could be utilised to obtain feedback in regards to the task analysed in the previous activity?
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